Disclaimer

This file includes has some accessibility problems. We will
demonstrate how to repair these issues through the course of
the training.
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Are you a...

Developer
Designer
Web content creator/author

Project manager
Something else?



True or False?

Accessible web desigh only benefits a
small percentage of the population.



8.5% of the population has a
disability that affects computer use

...does not include those with cognitive/learning disabilities,
color blindness, etc.



ogle is blind

...and deaf

...ahd can’t use a mouse



Assistive Technology

“Assistive technology promotes greater independence by
enabling people to perform tasks that they were formerly
unable to accomplish, or had great difficulty
accomplishing.”

Wikipedia



http://en.wikipedia.org/wiki/Assistive_technology

Do you use a form of
assistive technology?






True, False, or | don’t know?

My web content is currently accessible.



WCAG 2

* Principles based
— Perceivable
— Operable
— Understandable
— Robust

e WCAG 2.0 finalized in 2008
e WCAG 2.1 finalized June 2018



Normative

“Required for conformance”
Principles (POUR) > Guidelines >
Success Criteria

Success Criteria are assigned levels
— A, AA, or AAA




Non-normative

* “For information purposes and not
required for conformance”

e Supporting materials are non-
normative

* Understanding...

* How to Meet...

— Sufficient Techniques, Advisory
Techniques, and Failures




Principle 1 - Perceivable

Information and user interface components must be presentable to users in ways they can perceive.

Guideline 1.1 - Text Alternatives

Provide text alternatives for any non-text content so that it can be changed into other forms people need, such as large print, braille, speech, symbols or simpler

language.

? Show techniques and failures for 1.1

1.1.1 Non-text Content — Level A
All non-text content that is presented to the user has a text alternative that serves the equivalent purpose, except for the

O Understanding 1.1.1

situations listed below. » Show full description

> Show techniques and failures for 1.1.1
«<s SHARE |  BACKTO TOP

Guideline 1.2 - Time-based Media

Provide alternatives for time-based media,

1.2.1 Audio-only and Video-only (Prerecorded) — Level A

For prerecorded audio-only and prerecorded video-only media, the following are true, except when the audio or video is a © Understanding 1.2.1

media alternative for text and is clearli labeled as such: » Show full descriition


https://www.w3.org/WAI/WCAG21/quickref/

WeDAIM@  wcac 2 checkiist

web accessibility in mind

Principle 1: Perceivable
Web content is made available to the senses - sight, hearing, and/or touch

Guideline 1.1 Text Alternatives
Provide text alternatives for any non-text content

Success Criteria | Recommendations

1.1.1 Non-text 0 All images, form image buttons, and image map hot spots have appropriate, equivalent
Content alternative text.
(Level A)

[1 Images that do not convey content, are decorative, or contain content that is already
conveyed in text are given null alt text (alt="") or implemented as CSS backgrounds. All
linked images have descriptive alternative text.

[1 Equivalent alternatives to complex images are provided in context or on a separate
linked page.

[1 Form buttons have a descriptive value.

U Form inputs have associated text labels.

"I Embedded multimedia is identified via accessible text.

[0 Frames and iframes are appropriately titled.

Guideline 1.2 Time-based Media
Provide alternatives for time-based media

NOTE: If the audio or video is designated as an alternative to web content (e.g., an audio or sign language version of a
web page, for example), then the web content itself serves as the alternative.

Success Criteria | Recommendations

1.2.1.Pre¢rded [ A descriptive text transcript that includes relevant auditory content is provided for non-
A}lddlo-onll and live audio-only (audio podcasts, MP3 files, etc.).
ﬁ%ﬁ [1 A descriptive text transcript or audio description is provided for non-live video-only

(e.g., video that has no audio track), unless the video is decorative.

1.2.2 Captions [1 Synchronized captions are provided for non-live video (YouTube videos, etc.).
(Prerecorded)



https://webaim.org/standards/wcag/checklist

Your site can be compliant,
vet inaccessible



Your site can be technically accessible,
yet functionally inaccessible



Accessibility > Compliance



Section 508

Applies to federal government.

Agencies may require compliance for recipients of federal
funds.

* Section 504
Updated January 2018 to incorporate WCAG 2.0 A/AA

VPAT 2 — Voluntary Product Accessibility Template



Americans with Disabilities Act

Pre-dates the web

3 Titles — Employment, State and local governments, Public
and commercial facilities

Does not define technical standards for web accessibility

Lawsuits, complaints, and DOJ settlements require WCAG 2.0
A/AA



ADA Compliant?



Services drrticies resources community

WebAIM @

web accessibility in mind

WebAIM Training

We have web accessibility In mina

Our mission is to empower organizations to make their web content accessible to people with disabilities.

Accessibility Training 0 Accessible Site Certification @ Community
Whether here in Utah or on-site at your As a respected third party accessibility expert, WebAIM Blog
organization, WebAIM can provide WebAIM can evaluate and certify your site to
comprehensive training to fit your needs. established web accessibility guidelines.

Newsletter



skip to main content

WebAIM - Web Accessibility In Mind

Main Navigation Services Articles Resources Community

Search Terms

Introduction to Web Accessibility

WebAIM Training

We have web accessibility in mind

Our mission is to empower organizations to make their web content accessible to people with disabilities.
Accessibility Training

Whether here in Utah or on-site at your organization, WebAIM can provide comprehensive training to fit your

needs.
Accessible Site Certification

As a respected third party accessibility expert, WebAIM can evaluate and certify your site to established web

accessibility guidelines.
Technical Assistance
Need assistance implementing accessibility? WebAIM's expert staff can provide the assistance you need.

Evaluation and Reporting

We can provide reports to help you know how accessible your site is and how to make it better.

Community WebAIM Blog Newsletter E-mail Discussion List Twitter



skip to main content

WebAIM - Web Accessibility In Mind

Main Navigation

® Services

o Articles

o Resources
s Community

Search Terms |Sea|'-:h WebAIM F

Introduction to Web Accessibility

WebAIM Tramning

We have web accessibility in mind

Our mission 18 to empower organizations to make their web content accessible to people with disabilities.

Accessibility Training

Whether here in Utah or on-site at yvour organization, WebAIM can provide comprehensive tramning to fit your needs.



Focus on Content & Structure

* Headings
 Slide layouts (PowerPoint)
* Lists



Screen reader demo



Alternative Text



Alternative Text

Should...

* Be accurate and equivalent.
* Be succinct.

 NOT be redundant.

* NOT use the phrases "image of ..." or
"graphic of ..." to describe the image.



What is equivalent alternative text?

CONTENT and FUNCTION

VERY RARELY Description



If you couldn’t use a picture, what text
would you put in its place?



WebAIM @

web accessibility in mind



WebAIM @

web accessibility in mind






What if it's a link?



https://www.amazon.com/Wenger-16999-Swiss-Knife-Giant/dp/B001DZTJRQ

Q
|

"students studyilng
under a tree"??7?



Complex Images

Contents of a Beatles Song



Complex Images

* Provide the alternative in context OR
* Provide a link to page that contains the longer description
* The main image should still have descriptive alternative text
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e -Frgﬁr}l_sgﬁggm Plan a journey Status updates Maps Fares & payments Help & contacts More v @

fI Planajourney

Heathrow Airport Terminal 4 M Public transport | &b Cycling k Walking

Paddington
Travel by select all | deselect all

Leaving: now change time > E Bijs Tube

Hide preferences < National Rail DLR

. London Overground TfL Rail
Plan my journey

G River Bus Gl Tram
A T

Emirates Air Line Coach
My Journeys
' Show me Access options

up The fastest routes No accessibility requirement

Heathrow Airport Terminal 4 to

RicadilbCiteisdtonden Lk ' & Routes with fewest changes Use escalators, not stairs

@ Add favourites Turn off / clear A Routes with least walking Use stairs, not escalators

Step-free to platform only

Full step-free access




Kindle |

Cur most affordable Kindle Fire, now in HD

$139.00:

Storage Size: § GB

Offer Type: With S ial Offers

Special offers and

In Stock.
Ships f a d by Amazon D
Impartant infarm about using

Want it tomorrow, Feb. 197 Order hin 7 h
mins and ch One-Day Shipping at

We want you to know...
Learn more about design decisions and feature

changes to help make an informed purchase

Our most affordable Kindle Fire—now with a
stunning HD display, faster processor, and
longer battery life

JErence movies,
on a stunning HD

Fast 1.5GHz dual-c

apps launch
quickly, games and videos play smoathly

iles and set time limits children
se parental

ontrols let everyone enjoy, worry-free

Ultra-fast web browsing over built-in Wi-Fi,
plus updated e-mail and calendar support
Gmail, Outl and more

Instant acce
games in the A
new paid app free every day
Prime In addition to Free Ty
Prime members can stream tens

) apps and
re, including a

bay Shipping,

generati
Learn more




Descriptive link text

Click here

Click here to log in

Click here to log in

Log In







Tables



Layout tables

39% 67% 0% 3.42 02.59

Average Score High Score Low Score Standard Average Time
Deviation




Layout tables

39% 67% 0% 3.42 02.59

Average Score High Score Low Score Standard Average Time
Deviation




Layout tables

39% 67/% 0% 3.42 02.59

Average Score High Score Low Score Standard Average Time
Deviation




Data tables

Class Schedule

Class Name Course Number Location
Advanced Website 8IS 5650 3105
Development
Database BIS 3330 B220

Management




Data tables

Class Schedule

f—%

Class Name Course Number Location

; S

Advanced Website
Development >

BIS 5650 B105

Database
*

Y — BIS 3330 B220




Fall Semester

Class Name ‘Course Number Location
Advanced Website *BIS 650 3105
Development
Database BIS 3330 B220
Management




Fall Semester

Class Name Course Number Location
Advanced Website 31S 5650 3105
Development
Database BIS 3330 B220

Management




Fall Semester

Class Name Course Number Location
Advanced Website 3IS 5650 3105
Development
Database EEEL B220
Management
Winter Semester
Class Name Course Number Location
Advanced Website BIS 5650 105
Development
Database EEEL B220

Management




Fall Semester

Class Name Course Number Location
Advanced Website skeso 3105

Development

Database 5B330 B220

Management

Winter §enfester

Class Name CourseflNumber Location
Advanced Website S 0 3105

Development

Database _Ly, p1s 3330 B220

Management




Fall Semester

Class Name Course Number Location
Advanced Website 8IS 5650 3105
Development
Database IEEEL B220
Management

Winter Semester

Class Name Course Number Location

Advanced Website

BIS 5650 B105
Development

Database

R — SINICER]0 B220




Low Vision



Your Amazon.com Today's Deals Gift Cards Sell Help

amazon

Shop by

Department ~ Search Kindle Store

Buy a Kindle Kindle eBooks Advanced Search Daily Deals Free Reading Apps

Powerhouse tablets
Built for work and play

Fire HDX Fire HDX 8.9"
: 229 379
Compare Kindles ~ S 5

kindle [ Kindle Fire 7" Tablet, Now in HD

) ) 7" HD Display, Wi-Fi, 8GB or 16GB
Qur most affordable Kindle Fire, now in HD

v| (9,181 customer reviews)

MR

$ 1 39 - OO FREE Shipping Details

Storage Size: 8 GB

Offer Type: With Special Offers

[ — 1 ] : Special offers and sponsored scree
I Wwith Special ] Without Special | on the Kindle Fire lock screen. Lear




alliasavil

Try Prime

Shop by :
Department S Search Kindle Store H

Buy a Kindle Kindle eBooks Advanced Search Daily Deals Free Reading Apps Kindle Singles Newsstand

Your Amazon.com Today's Deals Gift Cards Sell Help

Powerhouse tablets
Built for work and play

Fire HDX 8.9"
Compare Kindles ~ $139 $379
kindle (1re 1o Kindle Fire 7" Tablet, Now in HD

7" HD Display, Wi-Fi, 8GB or 16GB

1y v (9,181 customer reviews)

o rY Y
'aRalal.

$ 1 39 ; OO FREE Shipping Details

Storage Size: § GB

Our most affordable Kindle Fire, now in HD

y |
| [ = I ol | | 4 4= =




Fire HD Fire HDX
$139 $229

Kindle Fire 7" Tablet, Now |
| | 7" HD Display, Wi-Fi, 8GB or 16GB
lle FII’E, now in HD Yryrdeyeys v (9,181 customer reviews)

J'-...I."-..J'\.r'l.

Se—m—— & SrEsss mEma



‘ally Important Texi

VS

Vitally Important Text



Inverted and High Contrast

amazon Your Amazon.com Today's Deals  Gift Cards Sell Help

Shop by : -
Department ~ Search Kindle Store

Buy a Kindle Kindle eBooks Advanced Search Daily Deals Free Reading Apps Kindle Singles News

0 O U

Kindle Kindle Paperwhlte Kindle F'aperwhlte 3G
Compare Kindles ~ gc2
kindle Kindle Fire 7" Tablet, Now in HD
_ . . 7" HD Display, Wi-Fi, 8GB or 16GB
Our most affordable Kindle Fire, nowin HD 4 Jevs 9] (9,181 customer reviews)

$ 1 39 . 00 FREE Shipping Details

Storage Size: 8 GB

8 GB 16 GB

A Offer Type: With Special Offers

i Special offers and
P With Special Without Soecial | an tha Kindla Fira




WCAG Contrast Formula

(L1 + 0.05) / (L2 + 0.05)
where
L=0.2126 * R+ 0.7152 * G+ 0.0722 * B
where
R, G, and B =

Rrep <= 0.03928 then R = R ;:/12.92
else R = ((R.zgg+0.055)/1.055) » 2.4

where
Reras < = Rgpit/ 255
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Level AA Contrast Examples
4.5:1 3:1 - “Large” text

Gray (#767676) on White >18 ol (24 pX)

Purple (#CC21CC) on White

Red (#F30000) on Yellow (#FFFFO0) BOLD: >14pt (18.67px)



WebAIM Contrast Checker

webaim.org/resources/contrastchecker/



http://webaim.org/resources/contrastchecker/

“Images of text”

50 most played
songs by genre

Mmusic
N’




We have the same contrast ratio

We have the same contrast ratio



We have the same contrast ratio

We have the same contrast ratio



Exceptions



“Incidental”

1}
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“Logotypes”

WebAlIM

web accessibility in mind



WCAG 2.1: Non-text Contrast

e Level AA

e 3:1 contrast of:
e User Interface Components (less common in documents)

* Graphical Objects



“Graphical Objects”




“Required to understand”

Twitter



“Against adjacent color(s)"




‘II

Exception — “Essentia

& Hichi [ Baltige srsalen Anmelsan

Hauplzene  Dseusson | Lesen Qusilee anosigen Wikipodia durchzuchan ﬁl

Willkammen bei Wikipedia

Wikipedia isi en Projekl oum Aullau enes Encyilopadie aus freien Inbalien, s denen du sebr gem beitrgen kannst, Sei Mai 2000 sind 2,008 3952 Astiked in dewescher Sprache sntstanden.
T Geographie 5 i W A runst und Kuhur ..n:ﬁim & spont 'denil W wissenschait
ch Themen - Artil n - Gesproche dia - Archiv der Hauptseite

Duess Sois wnime TUiste A 11 Jurd 2017 um L300 LI ceameier

SAhnsdswierk
Flar Twt e ininr cier | inarer Cimectas Comimons Ao fin e il weriigher minemaionen taen Lisheam and nm | e nevision singebsdeses Merisndeis i iesan Tl nder Feneilal huch Abqrlen werien e Intaiin
=1 rhamer i rich it i e T
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Color Blindness




An Example

The green mushrooms listed here are okay to eat. The red
mushrooms will kill you.

e Amanita

Chanterelle
* Porcini
 Shiitake
Tylopilus



An Example

The green mushrooms listed here are okay to eat. The red
mushrooms will kill you.

 Chanterelle
 Porcini
e Shiitake



1. Ensure enough contrast
2. Do not rely on color alone
- Don’t remove underline from links



Auditory Disabilities

I"'can do

o

P o) os20/1135 | @B 6 oo ;



1. Provide captions for video & live audio.
2. Provide text transcripts for all audio content.



Transcription Methods

* Typing ‘\Q\\
* Accurate, but very slow ‘\“

* Stenographer or “Shadow Speaker” \
* Accurate and fast, but expensive \

 Automated captioning \
* Free, but may require extensive

review/repair




Is officially tomatoes it's prisons rations?
He look for it.

l




Search for captioned videos

YoulRI'i: Center for Health Literacy Upload

About 12 200 results
JonAtwebAls

Watch Later Upload Date Rezult Type Duration Sort by

Watch History Last hour Video Short (~4 minutes) } (high definition} Relevance

Plaviists Today Channel Long (20~ minutes) : -aption) Upload date

Purch Thizs week Playlist Creative commons YView count
urchases

Thiz month Mowvie 30 Rating

This year Chow Live
What to watch i= ' -
Purchased

My subscriptions




Audio Description

Typically a narrator that describes visual content.
Sometimes called “Descriptive Video Service” (DVS).

Avoid expensive audio descriptions by ensuring
important visual content is presented audibly.

©)



What are additional benefits of
captions and transcripts?



Cognitive/Learning Disabilities

Most of these principles apply
* Headings

* Links

* Video Captions

* Contrast

e Alternative text (possibly)



Cognitive/Learning Disabilities

* Small text negatively impacts readability
— WCAG has no text size guidelines

* Avoid long line lengths
— Consider line height/spacing
* Be consistent



Avoid Full Justification

niscing elit. Pellentesque viverra ¢
nunc. Nam sed nisl nec elit susc
llamcorper. In leo ante, venenati
tpat ut, imperdiet auctor, enim.
avida. Suspendisse molestie sem

esent a lacus vitae turpis consed
per. Integer porta. Donec sit a
esent a eros. In hac habitasse pl

ctumst. Suspendisse fermentum.
em ipsum dolor sit amet, consect
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Thank You!

http://webaim.org

E-mail discussion list

Monthly newsletter

Tutorials, articles, and resources

 Blog

Web

web accessibility in mind

¢



Document
Accessibility Training

Web

web accessibility in mind

Jonathan Whiting and John Northup
WebAIM.org



Blindness



skip to main content

WebAIM - Web Accessibility In Mind

Main Navigation

® Services

o Articles

o Resources
s Community

Search Terms |Sea|'-:h WebAIM F

Introduction to Web Accessibility

WebAIM Tramning

We have web accessibility in mind

Our mission 18 to empower organizations to make their web content accessible to people with disabilities.

Accessibility Training

Whether here in Utah or on-site at yvour organization, WebAIM can provide comprehensive tramning to fit your needs.



Focus on Content & Structure



Focus on Content & Structure

Paste > “Keep Text Only” “Clear formatting”

"~ Paste Options:
i, 2

9 A




Paste Options Office




Use Headings



Headings in Word

e Use “Styles” toolbar
* Proper heading structure

AaBbCcDc. AaBbCcDe AaBbh i AaBbCcl AaBbCceD Aa Ij

-

— Usually one Heading 1

TMormal | TMNo Spac.. Headingl Heading2 Heading3 Title

— Don’t skip heading levels
e Ctrl+Alt+1,2 0r3

— command + option on Mac

Styles



PowerPoint?

INgs In

Where are the Head




Slide “Layouts”

INSERT DESIGM TRAMNSITIONS

| Layout =

15ection ~

Clipboard | Office Theme

1

Title and Content Section Header

1 1
I.-|.-|.-|.-|.-|.-|.-|.-|.-|.-|.-|.1.-|.:.-|.1.-|.-|.-|.1.-|.1.-|.1.-|.-|.-|.:
]




Decorative Images

You can hide images from a screen reader in Word or

PowerPoint, but only in Office 2019 or Office 365.
A screen reader will usually read "graphic”.

They will be hidden in PDF. If you have Office 2016, you will

need to hide in Acrobat.
Avoid decorative images when possible.



Alternative Text in Office 2016

Format Picture

— ]

Ay
A UTER ) e

> TEXT BOX

4 ALT TEXT
Title .

Description

ALTERNATIVETEXT HERE

Right-click the image and
choose Format Picture.

Select the Size[Layout] &
Properties icon and choose Alt

Text.

Enter appropriate alt text in
the Description field (not
Title).



Alternative Text in Office 365/2019

Alt Text N 1. Right-click the image and
How would you describe this object and its ChOOSE Edit Alt TEXt

context to someone who is blind?

2. Enter appropriate alt text in
the field.

—Or check Mark as decorative

(1-2 sentences recommended)

ALTERNATIVE TEXT HERE

Gene.-atMn for me Windows: DO NOT choose
“Generate a description for me”

Mark as decorative U



Tables practice

Class Schedule

Class Name Course Number Location

Advanced Website

BIS 5650 B105
Development

Database

YA T— BIS 3330 B220




Tables — other principles

e Use data table Styles only for data tables
* Avoid empty headers
* No need to add “Alt text” to tables



Editing Link Text

Edit Hyperlink
Limk to: Text to display: || ScreenTip..

L& Look in:
Existing File
or Web Page [@* 10things 2017-2 ST
Current
. Folder
%]
Place in This
Document Erowsed
Pages
]
Create Mew Recent
Document Files

_IJ Address: hitp:/fwww.amazon.com/Essentials-Online-Course-Design-5Standarg « Remove Link
E-mail

Cancel

Right click > Edit Hyperlink (or Ctrl + K ) > Text to display



For more information on this topic, read Essentials of Online
Course Design: A Standards-Based Guide-
http://www.amazon.com/Essentials-Online-Course-Design-
Standards-

Based/dp/0415873002/ref=sr 1 117?s=books&ie=UTF8&qid=132

9661475&sr=1-11 -



http://www.amazon.com/Essentials-Online-Course-Design-Standards-Based/dp/0415873002/ref=sr_1_11?s=books&ie=UTF8&qid=1329661475&sr=1-11

Lists

e Use true lists rather than
typing numbers or
inserting bullet
characters/icons

* Word/PowerPoint may
auto-create lists

* Ordered (numbered) or
unordered (bulleted) lists

* Nest lists appropriately

Re
e
=
=




4 Steps to Create Lists in Office:

-Decide what type of list you should use—bulleted or numbered
-Highlight text

-Choose the correct list type

-Spend the 5 minutes fixing auto-numbering ©



Columns

Use true columns rather than the Tab key to define columns.
This ensures proper reading order.

* Go to Page Layout on the Ribbon and select Columns.

HOME INSERT DESIGM PAGE LAYOUT REFEREMCES MAILINGS

— Breaks Indent Spacing

' Line Numbers = 3= Left: (0" Before: |0 pt
fc Hyphenation~ =% Right: 0" After: |8 pt
P Paragraph




Reading Order

The object on a
slide's bottom layer

...1Is read first by a

screen reader.




Selection Pane

Insert Draw Design Transitions Animations Slide Show Review View Help ACROBAT C;

Selection

Show All | Hide All

Paragraph Order Objects
Bent Arrow 5

TextBox 3

TextBox 6

Content Placeholder 3
Title 1

Group Objects

There's that logo again

Reading Orc

Selection Pane

Position Objects
e tab > Arrange > Selection Pane

= .
Inserting items on the page u |(- Align
boxes, etc. can sometimes ca
reading order issues




Reading Order Practice

Inserting items on the page using text
boxes, etc. can sometimes cause
reading order issues

WebAIM G =

web accessibility in mind

There’s that logo again



Give Documents Descriptive Titles



Info
New
Open
Save
Save As
Print

Share

| g

Document Title

Document1 - Word

Info

Protect Document Properties -

? Control what types of changes people can Size Not saved yet

Protect make to this document.

Pages
Document - 9

Inspect Document

J Before publishing this file, be aware that it
Check for  contains:

Issues ~ Document properties and author's name
Comments Add comments



Check accessibility



Windows: File > Check for Issues> Check
Accessibility

Infa
Hew

Open

Save As

Save as Adobe PDF
Print

Share

Export

Close

Account
Feedback

Options

Protect Presentation
C ol what Ty people can make to

Protect

Presentation -

Inspect Presentation

s file, be aware t

Check Accessibility

(% Check the presentatio

ii5

Acce
Inspection Results
Er
4 Missing alternative text
Picture 4 (Slide 7)
4 Table has no header row
Content Placeholder 3 (Slide 10)

4 Table has merged or split cells
Content Placeholder 3 - - 1 Cell (Slide 10)
Tips
4 Cherk readina arder
Additional Information
Why Fix?
Alternative

en reader




Mac: Review tab > Check Accessibility

O -

Design Transitions Animations Slide Show

Maw Show Restrict
Comment Comments Permission




PDF in a nutshell

* PDF is a file format
* Do as much as you can in the source document

* Need Acrobat Pro to make accessibility changes to PDF



Convert to PDF

TR o —— * Windows: Acrobat tab
File Horne| Insertl Desngn|Transrt|on|An|mat|or|SI|deShov| Rewewl\l 1 w_F.t_‘:E:qT Q Tell
= > Create PDF

|

— If not available, use
Attach to Email Shared Commenting Run Action Flash ”Save AS"

Create |Preferences Create and Create and Send For Create PDF and Embed

Create and Email Review And Comment Create and Run Action Flash

e Mac: In Acrobat, File >
Create

* Do NOT print



Start with the Source Document

Headings * Contrast
Alternative text for images® ¢ Color reliance
Tables™  Document title
Links

Lists

Columns

Text size

*Decorative images, complex images, and tables
may need cleanup in Acrobat.
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+ Testing Web content for Accessibility
1 tool that facilitates human
content.
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Tags Pane Accessibility Tools

@ Tags
N BE-O

I:a Autotag Document

@ v EI Tags
D v [E] <Sect>

_ff <H1>
' Z ? 1] . Reading Options
> <P>
> f <H2> @ Full Check

v Tf <L> o e
® Accessibility Report
> §F <L>
5 "’f <LI>
> 1’| <P>

S’« |dentify Form Fields

Set Alternate Text

*‘+\ Setup Assistant

|:§ Reading Order




Main steps

1. Run accessibility “Full Check”

—  Make easy repairs

2. Repair tag structure with “Reading Order” tool
3. Fix content reading order (optional)
4. Verify tag structure and order in “Tags” pane
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